
 1 

HP Service Manager 

for supported Windows® and UNIX® operating systems 

Release Notes 

Software version: 9.21.113 Patch 2 / April 2011 (Updated March 23, 2012) 

This document provides an overview of the changes made to HP Service Manager for 9.21.113 Patch 2. It 
contains important information not included in the manuals or in online help. 

Documentation Updates ......................................................................................................................... 2 
In This Version ........................................................................................................................................ 3 

Web client updates ............................................................................................................................................. 3 
Windows client updates...................................................................................................................................... 7 
Server updates .................................................................................................................................................... 7 
Application updates .......................................................................................................................................... 11 

Known Problems, Limitations, and Workarounds .............................................................................. 11 
Installation Notes .................................................................................................................................. 12 

Web Tier installation ........................................................................................................................................ 12 
Windows client installation ............................................................................................................................. 13 
Server installation ............................................................................................................................................ 13 
Application unload installation ....................................................................................................................... 14 

New Parameters and JavaScript .......................................................................................................... 15 
Startup parameter: msg_buffer_size ............................................................................................................... 15 
Startup parameter: soap12binding ................................................................................................................. 16 
Startup parameter: usealtsignalstack ............................................................................................................. 16 
Startup parameter: usemembar ...................................................................................................................... 17 
Web parameter: secureLogin ........................................................................................................................... 18 
Web parameter: sslPort .................................................................................................................................... 18 
JavaScript global method: doSOAPRequest ................................................................................................... 19 

Verified Environments .......................................................................................................................... 21 
Local Language Support ....................................................................................................................... 21 
Support .................................................................................................................................................. 21 
Legal Notices ......................................................................................................................................... 22 

 



 2 

Documentation Updates 

The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL:  
http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

Note: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site:  
http://www.adobe.com/ 

http://h20230.www2.hp.com/selfsolve/manuals�
http://h20229.www2.hp.com/passport-registration.html�
http://www.adobe.com/�
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In This Version 

Service Manager Version 9.21, build 113 Patch 2 (SM 9.21p2) includes several customer requested software 
enhancements and fixes. Refer to the sections below for information about the defects and enhancements for 
each release included in this cumulative patch. 

Service Manager 9.21 Patch 2 updates the following areas: 

• Web client updates included in SM9.21p2 

• Windows client updates included in SM9.21p2 

• Server updates included in SM9.21p2 

• Application updates included in SM9.21p2 

Web client updates  

The following items (identified by reference number) are fixed in the current software release.  

CR Problem Solution 

QCCR1E55936 Only one approval record is shown in the 
web client. 

The web client correctly displays all 
approval records. 

QCCR1E56203 In the Service Manager 9.20 web client, 
pop-up subforms only stay up for five 
seconds. Found some code in the web client 
that infers it is waiting for an 'esc', 'tab,' or 
'onblur' to close the pop-up.  However, it 
seems too close after five seconds.  There is 
other code that seems to infer the window 
is closed after tod()+250, but unaware of 
what the 250 is or how that translates to 5 
seconds. 
The web client should work like the 
Windows client where the pop-up stays up 
until the user wants to close it. 

Hover forms will always display when 
focusing on the field. 

QCCR1E57102 On the web client, when the customer 
searches for a change and then opens the 
task from the change work flow, the task 
opens in a new tab, which still contains the 
search results for the changes and the task 
buttons (for example, Cancel and Save & 
Exit) icons all disappear and cannot be 
used. 

Search results will no longer appear in the 
new tab, and task buttons will be available. 

QCCR1E57656 List Builder is working differently (values 
do not get saved) in the web client versus 
the Windows (desktop) client. 

List Builder in the web client saves values 
the same as in the Windows client. 
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QCCR1E58371 HP WebInspect incorrectly identifies the 
presence of certain third-party files, which 
are not used in the product, as potential 
vulnerabilities. 

The unnecessary files have been removed 
from the product. 

Note: Be sure to set up your Web Tier with 
only the minimum required functionality. 
Enabling more functionality in web and 
application servers (extra languages or 
scripts such as VB, PHP, CGI, and so on),  
increases the risk of security breaches. HP 
recommends that you follow well-known 
best practices for secure application server 
setup.  

QCCR1E58476 Form rendering on lower resolution screens 
does not work correctly on the web client. 
Any resolution less than 1280x960 has 
issues rendering forms. For example, the 
search form for an incident or a new OOB 
incident form both render with a horizontal 
scroll bar located under the form 
component that has focus, instead of being 
justified to the left. This happens 
regardless of form width. 

A horizontal scroll bar is not displayed in 
resolution 1024x768 for a maximized 
window, unless the form is wide enough to 
require one. 

Note: HP recommends a screen resolution 
of  1024x768 or higher. 

QCCR1E58775 Text fields set to read-only can be edited in 
the web client, even though they are 
displayed in gray text. 

Text fields set to read-only can no longer be 
edited in the web client. 

QCCR1E58949 When web client users try to download an 
attachment that contains special 
characters, such as # and %, in the file 
name, the browser displays a 404 Error, 
Requested File Not Found.   

The web client has been updated to 
correctly handle file attachments containing 
names which include punctuation marks, as 
well as different languages. 
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QCCR1E59295 Inconsistent behavior when adding views 
using different methods. 
1) Log in as 'falcon.' 
2) Click 'Search incidents' and specify 

status=Work in progress, then click 
'Search.' 

3) Click 'Add Favorites' button in left 
navigator and name the view 'Test - 
add favorites.' 

4) Click 'More -> Save as View' and name 
the view 'Test - save as view', click OK 
(you may have to log out and back in to 
see new view in left navigator). 

5) Click 'manage favorites' and select 
'Test - add favorites' view, then 'Test - 
save as view' view. 

6) Notice two differences: 
a. View definitions tab is not available 

on 'Test - add favorites' 
b. Query tab displays different fields 

between the 2 views 
The expectation is that these 2 views would 
be identical. 

List view can be saved in Favorites when 
"viewrecordlist" is false. 

QCCR1E59406 Unable to perform a Find function with a 
conditional read-only Comfill or with the 
Find tool bar button in the web client.  

The Find functionality now works in the 
web client, even when there is a read-only 
condition on the field. 

QCCR1E60040 Clicking the [X] on an inactive tab in the 
web client closes the active tab instead. If 
the active tab is the first tab (for example, 
the To Do Queue), then the web client 
connection is terminated. 

The [X] close button on inactive tabs has 
been removed to avoid conflicts within the 
tab's hidden content when trying to close it.  
The F5 key is now intercepted to avoid 
performing a browser refresh, which is not 
supported by the application. 

QCCR1E60047 Custom selections are not recognized as 
selected when a user creates a quote 
request in the web client. Only the 
mandatory line items are included.  

Selecting line items in the web client works 
fine; users will get the same result as in the 
Windows client. 

QCCR1E60796 The Comfill fill button visible condition and 
third button visible condition do not work 
on the web client. 

The visible conditions for both buttons work 
properly. 

QCCR1E60816 In the web client, the Navigator Menu may 
disappear after a user refreshes the 
browser. 

The Navigator Menu now displays correctly 
after a user refreshes the browser. 
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QCCR1E61074 The pop-up subformat enabled on a field for 
mouse over in the web client does not 
display, if the field has a read-only 
condition defined.   
The pop-up form for the same field will 
display correctly when the read-only check 
box is checked with no read-only condition.  

The read-only Comfill widget will display in 
the pop-up subform, if the read-only 
condition exists. 

QCCR1E61109 Comfill misalignment in the web client, if 
Comfill has read-only and visible conditions 
set. 

Skipped a JavaScript function, which does 
not apply to Comfill due to its complex 
structure. 

QCCR1E61170 The Status field is cleared when a user 
moves the mouse over the field in specific 
conditions on the web client. 

The status filed will not change when 
moving the mouse out of the field. 

QCCR1E61680 The Service Manager Web Tier should be 
enhanced to require SSL for 
communication by default. 

Added two context parameters to the Web 
Tier configuration file (web.xml) for secure 
login: 

secureLogin: Set to true if SSL 
connections are enabled on the web 
application server and logins should be 
secure; set to false if SSL connections are 
disabled, or only non-SSL connections are 
allowed. Default is true. 

sslPort:  Set this parameter to the SSL 
port on the web application server when the 
secureLogin parameter is set to true. 

Note: HP recommends using SSL for 
connections to the Service Manager web 
application. 

For more information on these new 
parameters, see New Parameters and 
JavaScript.   

QCCR1E62244 Changing tabs and closing them during a 
search could sometimes result in all tabs 
being closed and the JavaScript error, 
"cwc.getActiveTab() is null". 
This happened because the browser tried to 
render a response on the new tab instead of 
the tab that generated the request. 

Fixed the tabs so that you cannot switch 
from one to another while one is waiting for 
a response from the server. 

QCCR1E62290 Web client returns Display string data 
instead of Value string. 

Client has been corrected to return the 
Value string rather than the Display string. 
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Windows client updates  

The following items (identified by reference number) are fixed in the current software release.  

CR Problem Solution 

QCCR1E30694 When viewing a record using the HTML 
editor (WYSIWYG) on the Windows client, 
if the display screen does not allow input 
and the displayed record has text that 
spans more than one page, the scroll bar 
cannot be used. 

The read-only HTML editor can scroll to 
read the whole text area on the Windows 
client. 

QCCR1E54855 Deselecting the "Skipping readonly controls 
when tabbing" option in preferences does 
not work. 

This option has been removed. 

QCCR1E55918 Attempting to escalate an interaction to an 
incident by using the wizard, clicking the 
Next button and then continuing to click 
while the server is working, sometimes 
breaks the user session. 

The Windows client will now complete 
processing of any given request action 
before allowing another request to be sent 
to the Service Manager server. 

QCCR1E57264 In the Windows client, double-clicking on a 
table row fails to select the row. 

Double-clicking on a table row now selects 
it, as expected in the Windows client.  

QCCR1E59380 The "Desc" column is not sorted. The "Desc" column can be sorted. 

Server updates  

The following items (identified by reference number) are fixed in the current software release.  

CR Problem Solution 

QCCR1E32063 On UNIX, processes spawned by Service 
Manager running a shell script fail to 
terminate properly after execution. 

On UNIX, processes spawned by Service 
Manager running a shell script now 
terminate properly after execution. 

QCCR1E32084 Messages sent through the notification 
engine are truncated if the array element is 
greater than 8191 characters. 

The size (number of bytes) of the message 
buffer used to store the current notification 
messages can now be set by the parameter: 
msg_buffer_size.  

Note: When this parameter is set to be less 
than the default (8192 bytes), the server 
uses the default. 
For more information on this new 
parameter, see New Parameters and 
JavaScript.   

QCCR1E56092 When mapped to an Oracle database and 
updating a record violating the unique key 
constraint, Service Manager continued as if 
the record had been modified since read. 
This could affect application behavior. 

When mapped to an Oracle database and 
updating a record violating the unique key 
constraint, Service Manager shows the 
correct error message, "The record being 
added contains a duplicate key." 
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QCCR1E56417 Unable to consume external Web Services 
with Fast Infoset. On executing a call to an 
external Web Service, the Web Service call 
fails to send the SOAP request and logs the 
following exception. 
Cannot evaluate expression 
display,process.option) 
Script <unknown script>  line 0: ERROR 
uncaught exception:  
Error calling method: doSoapRequest in 
class:com/hp/ov/sm/server/utility/SoapClient 
Exception (java.lang.ClassCastException: 
org.jvnet.fastinfoset.FastInfosetSource) at 
char 1 
Error calling method: doSoapRequest in 
class:com/hp/ov/sm/server/utility/SoapClient 
Exception (java.lang.ClassCastException: 
org.jvnet.fastinfoset.FastInfosetSource) 

Modified JavaScript doSoapRequest() 
method to take a new argument: 
"acceptfastinfoset" to turn 
acceptfastinfoset on/off. 
The default value, 
acceptfastinfoset:1, keeps the original 
behavior. 

Put acceptfastinfoset:0 in your 
sm.ini file to consume Web Services with 
Fast Infoset. 
For more information on this new 
JavaScript function, see New Parameters 
and JavaScript. 

QCCR1E57043 In the uCMDB/Service Manager 
integration, a configuration item (CI) 
replication job will abort if one of the CIs 
runs into a data type mismatch error. 

Service Manager now handles data type 
mismatch errors as part of a normal SOAP 
response in Service Manager, instead of 
returning a SOAP fault. The http session 
remains open and the CI replication job 
does not abort. 

QCCR1E59040 When running with the parameter 
memdebug:400 on HP-UX Itanium, memory 
leaks might be reported, but they never 
include any stack trace. 

Any leaks reported through the parameter 
memdebug:400 should include stack traces 
on HP-UX Itanium. 

QCCR1E59521 Load balancer won't start on Linux 
systems. 

Added two new Service Manager Server 
parameters: usealtsignalstack and 
usemembar.  

Note: These two parameters only apply to 
UNIX platforms. 
By default, the usealtsignalstack is turned 
on for all the UNIX platforms.  
The default value for usemembar in LINUX 
is 1 (starting JVM with option -
XX:+UseMembar). 

The default value for usemembar in all the 
other UNIX platforms is 0 (starting JVM 
without option -XX:+UseMembar). 

Important: HP recommends that you set 
these parameters in the sm.ini file. 

For more information on these new 
parameters, see New Parameters and 
JavaScript. 
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QCCR1E60186 When using the RAD function delete() on an 
array that only contains NULL values, 
delete() returns the original array and does 
not delete any elements from the array. 

The RAD function delete() now deletes 
elements from an array, even if all the 
elements in the array are NULL. 

QCCR1E60666 Number of records returned by using the 
count function and by using a query is not 
the same. 

The number of records returned by using 
the count function now matches the 
number of records returned by a query. 

QCCR1E60849 The group items and group count in a 
search list are not correct after a record is 
removed from the search list because it no 
longer matches the original query. 

Grouping information is now properly 
updated when a record is removed from a 
search list. 

QCCR1E60986 Inactive sessions are not cleaned up and the 
TRClient dies with a signal 11 when 
processing killInactiveSession requests, if 
the excluded user's parameter has a null 
value. 

Inactive sessions are cleaned up and the 
TRClient functions properly when 
processing killInactiveSessions requests, 
even when the excluded user's parameter 
has a null value. 

QCCR1E60987 A TRClient thread is the processing thread 
for all locks, inactivity, and userchain 
requests from one Service Manager (SM) 
process to another SM process. If this 
thread dies, the other SM process cannot 
acquire any lock requests and will report an 
error in the log file. 

When the TRClient thread dies, a new one 
will be started to process all the locks, 
inactivity, and userchain requests. 

QCCR1E61007 Searching for records that contain certain 
criteria that the RDBMS cannot evaluate, 
displays only 32 results in the search list, 
even when the database contains more than 
32 records that match the criteria. 

The search list now shows all matching 
records, even if the RDBMS cannot 
evaluate the query directly. 

QCCR1E61101 Connect-IT is unable to connect to Service 
Manager (SM).  When SM added the Soap 
1.2 Binding to SM's WSDL, it caused a 
backward compatibility issue with the Web 
Service clients that were created by the 
Web Service tools that could not parse or 
build  the new SM WSDL. 

Added a new SM server startup parameter, 
soap12binding:  

0 = Do not include soap12 binding 
1 = Do include soap12 binding 
The default is "Do not include soap12 
binding" to make the SM WSDL backward 
compatible. 
For more information on this new 
parameter, see New Parameters and 
JavaScript. 

QCCR1E61484 When the JavaScript function join() is used, 
the Service Manager server process leaks 
memory. 

Memory allocated during join() JavaScript 
function is now properly released. 

QCCR1E61905 When log rotation is executed, an additional 
file handle is created and not freed. This 
may cause the process to reaching the 
Operating System limits on file handles. 

Service Manager now checks for existence 
of log locking handle after the log rotation 
is called to avoid creating a duplicate file 
handle. 
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QCCR1E61960 When you add a field from a file to multiple 
subforms, the field data displays correctly 
on the first subform but disappears on all 
subsequent subforms. 

When you add a field from a file to multiple 
subforms, the data displays correctly on all 
the subforms. 

QCCR1E61995 When using an "isin" query with many 
search elements, if one of the elements 
contains a single quote ('), Service Manager 
does not properly escape that single quote 
before using the data in the generated SQL 
statement. The RDBMS then fails to parse 
the query. 

Service Manager properly escapes single 
quotes in data before using it literally in 
SQL statements, and does not escape single 
quotes when using bind variables. 

QCCR1E62044 Recursive signal 11 followed by the error: 
"Signal could not be handled due to missing 
jmp buffer" in the sm.log file. Signal jump 
buffer, which is a mechanism on 
Unix/Linux to shift control to Java code 
during signal handling, is not defined 
during initialization of some threads. When 
jump buffers are not defined, signals may 
run recursively. 

Signal jump buffers are now defined in all 
instances of thread initializations to avoid 
recursive signals. 

QCCR1E62052 When the Web Services client was not 
configured with pre-emptive basic 
authorization, Service Manager responded 
with a SoapFault instead of a 401 
Unauthorized HTTP response. 

When the Web Services client is not 
configured with pre-emptive basic 
authorization, Service Manager now sends 
back a 401 Unauthorized HTTP response to 
continue the client/server communication. 

QCCR1E62145 The Kill inactive warning message 
functionality has changed and is now too 
frequent if setup as in previous versions. 

Client will now receive warning messages 
only during the warning interval.  
The Warning interval and Inactivity 
Scheduler interval should be configured 
with same value, otherwise in some cases 
client may receive more than one warning 
message. For example, if you have specified 
"Number of minutes to allow idle user " at 
2 hours, and "Warn user within " 10 
minutes of termination, and inactivity 
scheduler to run at every 2 minutes, then 
the client may receive about 5 warning 
messages during the last 10 minutes of the 
inactivity period.  

Note: To avoid duplicate warning messages 
to the client, be sure to configure the Warn 
user within" and the "Inactivity Scheduler" 
to the same value. 

QCCR1E62199 When logging in to Service Manager with 
LDAP and a case-sensitive RDBMS, when 
the case of the user id is different between 
the RDBMS and LDAP, and LDAP is 
configured as a secondary data source, the 
user might see a "Modified since read" 
message. 

When logging in to Service Manager with 
LDAP and a case-sensitive RDBMS, if 
Service Manager finds that the user ID on 
the RDBMS differs from the one on LDAP 
in case, it no longer attempts to update the 
operator record. 
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Application updates  

The following items (identified by reference number) are fixed in the current software release.  

CR Problem Solution 

QCCR1E31545 If a template value contains backslashes, 
applying this value will cause the 
corresponding field to contain an additional 
backslash for every backslash in the value.  
For example, if the template value is:  
This\is\a\test the resulting value will be:  
This\\is\\a\\test. 

Backslashes included in a template value 
are no longer duplicated in the output.  

Important: To take advantage of the 
update, you must load 
QCCR1E31545_SM921P2.unl, which 
contains the updated application.  
This improvement requires Web Tier 
change QCCR1E60047. 
Additionally, if you are using Service 
Manager server/client 9.21p2 with 
Applications 7.11, you also need to load 
QCCR1E31545_SM921P2_SM711.unl (This 
additional unload is not required for 
Applications 7.00).  

Known Problems, Limitations, and Workarounds 

This software release has the following known issues. 

Global ID  Known Issue  Workaround  

QCCR1E63340 When opening a change record which is in 
the "Subscription" phase, the "Next 
Expiration" text box overlaps the header of 
the table for SLO items. 

None available at this time 
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Installation Notes 

Before using patch 9.21.113 Patch 2 and all subsequent patches, you must manually remove the files listed 
below. 

Remove the following files from the "\RUN\lib" directory:  

• saaj-impl-2.1.jar  

• saaj-api-2.1.jar 

• jgroups-all-2.5.0.jar 

Remove the following files from the "\RUN\lib\endorsed" directory:  

• xercesImpl-jaxp-1.3.2.jar 

• xalan-jaxp-1.3.2.jar 

• jaxp-api-1.3.2.jar 

• dom-jaxp-1.3.2.jar 

• sax-jaxp-1.3.2.jar 

Web Tier installation 

The Web Tier update consists of a compressed file, sm9.21.113-P2_Web_Tier.zip. The specific upgrade 
process depends on your particular Web application server, but follows the same steps as deploying a new 
installation. For more information, refer to the Service Manager Installation Guide. 

The upgrade does not automatically save your Web Tier customizations. To keep your changes, you must 
save your customized files and replace the new version of these files with your customized version. 

To install the Web Tier update: 

1 Back up your web.xml file, splash screen, style sheets, and any other customizations you made, including 
your webtier-9.21.war (.ear) file. 

2 Delete or uninstall the existing webtier-9.21.war (.ear) file. 

Note: The "Update Application" function in WebSphere Application Server 6.x allows you to redeploy 
using a new copy of webtier-9.21.war (.ear). First, update the web.xml in the webtier-9.21.war 
(.ear) file, and then redo the shared library configuration. For more information, see the IBM 
WebSphere documentation. 

3 Deploy the new webtier-9.21.war (.ear) file by following the instructions in the Service Manager 
Installation Guide. 

4 Replace the new versions of any files you customized with your customized versions. 

5 Make any new customizations necessary for your deployment. 
Be sure to set the securelogin and sslport parameters. 

6 Restart the Application server. 
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Windows client installation 

The Windows client update consists of a compressed file, sm9.21.113-P2_Win_Client.zip, which 
contains setup.exe. 

To install the Windows client update: 

1 Stop the Service Manager Windows client. 

2 Uninstall the Service Manager Windows client. (Your connection and personalized settings are retained.) 

3 Run setup.exe and install the client by following the instructions in the Service Manager Installation 
guide and Release Notes for your version. 

4 Check the version in Help > About Service Manager Client.  
The client should be Release: 9.21.113. 

Server installation 

The server update for your operating system (OS) consists of a compressed file, sm9.21.113-P2_<OS>.zip  
(or .tar), which contains the Service Manager server files. These files add to or replace the files in the [SM 
Root]\ ([SM Root]/) RUN, irlang, legacyintegration, and platform_unloads directories. 

To install the Server update: 

1 Stop all Service Manager clients. 

2 Stop the Service Manager server. 

3 Make a backup of the RUN directory. 

4 Extract the compressed files for your operating system into the main Service Manager directory on the 
server. The default path is:  C:\Program Files\HP\Service Manager 9.21. 

5 For UNIX servers, set the file permissions for all Service Manager files to 755. 

6 Remove the following files from the "\RUN\lib" directory:  

• saaj-impl-2.1.jar 
• saaj-api-2.1.jar 
• jgroups-all-2.5.0.jar 

7 Remove the following files from the "\RUN\lib\endorsed" directory:  

• xercesImpl-jaxp-1.3.2.jar 
• xalan-jaxp-1.3.2.jar 
• jaxp-api-1.3.2.jar 
• dom-jaxp-1.3.2.jar 
• sax-jaxp-1.3.2.jar 

8 Restart the Service Manager server. 

9 Restart the Service Manager clients. 

10 Check the version in Help > About Service Manager Server.  
The server should be Release: 9.21.113. 
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Application unload installation 

The application consists of the unload files that come with the server update. When you extract 
sm9.21.113-P2_<OS>.zip (or .tar), it will add the new files to your  
[SM Root]\platform_unloads ([SM Root]/platform_unloads) directory.  

To install the new applications load the following unload files: 

• QCCR1E31545_SM921P2_SM920.unl, which prevents backslashes included in a template from being 
duplicated in the output. 

Note: If you are using Service Manager server/client 9.21p2 with Applications 7.11, you also need to load 
QCCR1E31545_SM921P2_SM711.unl (This additional unload is not required for Applications 7.00). 

Additional application updates have been included with this cumulative release. If you have not already 
applied them for a previous patch, you should also apply the unload files below. For more details, see the 
Release Notes for those patches, also included with the release. 

• QCCR1E55715_SM921p1.unl, which includes application changes to reduce database I/O on login. 

• QCCR1E57767_SM921p1.unl, which includes application changes to reduce jgroups traffic on login. 

• QCCR1E59753_SM921p1.unl, which includes application changes to fix the ToDo bar.  

To load an unload file: 

1 Select either client or server-side unload, depending on the location of the unload files. 

a) From the Windows client, go to Window > Preference > HP Service Manager.  

b) Flag Client-Side Load/Unload if the files are on the client machine, unflag it if not.  

c) Restart the Windows client if you changed the setting.  

2 Open Tailoring > Database Manager. 

3 Right-click the form or open the options menu and select Import/Load. 

4 Fill in the following fields. 

Field Description 

File Name Type the name and path of the file to load. 

Import Descriptor Since unload files do not require an Import Descriptor record, leave this field 
blank. 

File Type Select the source operating system of the unload file. 

Messages Option —  
All Messages 

Select this option to see all messages that Service Manager generates loading the 
file. 

Messages Option —  
Totals Only 

Select this option to see only the total number of files Service Manager loads. 

Messages Option — 
None 

Select this option to hide all messages that Service Manager generates when 
loading the file. 

Note: You can view the contents of an unload file before importing it by clicking List Contents. 

5 Click Load FG.  
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New Parameters and JavaScript 

Several defects fixes are supported by new or updated parameters or JavaScript functions. 

Updated parameters: 

• Startup parameter: msg_buffer_size 

• Startup parameter: soap12binding 

• Startup parameter: usealtsignalstack 

• Startup parameter: usemembar 

• Web parameter: secureLogin 

• Web parameter: sslPort 

New and updated JavaScript features: 

• JavaScript global method: doSOAPRequest 

Startup parameter: msg_buffer_size 

Startup parameters change the behavior of the HP Service Manager server. You can always set a startup 
parameter from the server's OS command prompt. 

Description 
This parameter defines the size (number of bytes) of message buffer used to store the current notification 
message inside the Service Manager server, which will be displayed in the Messages view of the client. 

Note: When this parameter is set to be less than the default (8192 bytes), the server will use the default 
value. 

Valid if set from 
Server's OS command prompt 
Initialization file (sm.ini) 

Requires restart of HP Service Manager server? 
No 

Default value 
8192 

Possible values 
8192 or above 

Example usage 
Command line: sm -httpPort:13080 -msg_buffer_size:10000 
Initialization file: msg_buffer_size:10000 
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Startup parameter: soap12binding 

Startup parameters change the behavior of the HP Service Manager server. You can always set a startup 
parameter from the server's OS command prompt. 

Description 
Service Manager by default generates WSDLs conforming to both soap 1.1 and soap 1.2 bindings.  However 
some Web Services clients do not accept both soap 1.1 and soap 1.2. In such cases, you can disable 
soap12binding by providing the parameter soap12binding:0. 

Valid if set from 
Server's OS command prompt 
Initialization file (sm.ini) 

Requires restart of Service Manager server? 
No  

Note: Existing connections will honor the current value. New connections will honor the new value. 

Default value 
1 

Possible values 
0 (Disabled)  
1 (Enabled) 

Example usage 
Command line: sm- httpPort:13080 –debugnode:1 –soap12binding:0 
Initialization file: soap12binding:0 

Startup parameter: usealtsignalstack 

Startup parameters change the behavior of the HP Service Manager server. You can always set a startup 
parameter from the server's OS command prompt. 

Description 
By default, the Service Manager processes register the alternate signal handler to handle signals generated 
by the operating system.  When usealtsignalstack is enabled, the processes handle StackOverFlow 
Exceptions properly. The signal is delivered on an alternate stack, and the process has a chance to terminate 
the offending thread and continue to requests of other threads that exist on the process. Older Linux Kernels 
may not honor the alternate signal stack. If you are running on older Linux Kernels, disable this feature. 

Note: This parameter applies only to UNIX platforms. 

Valid if set from 
Initialization file (sm.ini) 
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Requires restart of Service Manager server? 
Yes 

Default value 
1 

Possible values 
0 (Disabled) 
1 (Enabled) 

Example usage 
Command line: sm –httpPort:13080 –usealtsignalstack:1  
Initialization file: usealtsignalstack:1  

Startup parameter: usemembar 

Startup parameters change the behavior of the HP Service Manager server. You can always set a startup 
parameter from the server's OS command prompt. 

Description 
When this parameter is provided, Service Manager creates a JVM with the parameter –XX:+UseMemBar. 
When usealtsignalstack is enabled on Linux platforms, Service Manager runs into a known JVM issue. 
The JVM needs –XX:+UseMemBar to avoid running into the known issue. 

Note: This parameter applies only to UNIX platforms. 

Valid if set from 
Initialization file (sm.ini) 

Requires restart of Service Manager server 
Yes 

Default value 
In LINUX: 1 (start the JVM with option -XX:+UseMembar). 
In all the other UNIX platforms: 0 (start the JVM without option -XX:+UseMembar). 

Possible values 
0  (Disabled) 
1 (Enabled) 

Example usage 
Command line: sm -httpPort:13080 –usealtsignalstack:1 –usemembar:1  
Initialization file:  
usealtsignalstack:1 
usemembar:1 
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Web parameter: secureLogin 

Web parameters change the behavior of Web clients connecting to the Web Tier. You can set some of these 
parameters from the Web client login URL, some from the Web Tier configuration file (web.xml), and some 
from both. 

Description 
This parameter controls the encryption of network communication between the Web application server and 
the Web browser. Enabling this parameter causes Web browsers to use SSL connections to the Web 
application server.  

Note: To use secure login, you must enable SSL connections on the Web application server. 

Valid if set from 
Web Tier configuration file (web.xml) 

Requires restart of Web application server? 
Yes 

Default value 
true 

Possible values 
true (Enabled) 
false (Disabled) 

Example usage in web.xml 
<context-param> 
<param-name>secureLogin</param-name> 
<param-value>true</param-value> 
</context-param> 

Web parameter: sslPort 

Web parameters change the behavior of Web clients connecting to the Web Tier. You can set some of these 
parameters from the Web client login URL, some from the Web Tier configuration file (web.xml), and some 
from both. 

Description 
This parameter should be set to the SSL port of the Web application server. Required only when the 
secureLogin parameter is set to true. 

Valid if set from 
Web Tier configuration file (web.xml) 

Requires restart of Web application server? 
Yes 
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Default value 
8443 

Possible values 
SSL port number 

Example usage in web.xml 
<context-param> 
<param-name>sslPort</param-name> 
<param-value>8443</param-value> 
</context-param> 

JavaScript global method: doSOAPRequest 

This method issues a SOAP request to a specified URL. 

Syntax 
doSOAPRequest( URL, SOAPAction, XML, SOAP user ID, SOAP password, Attachment object, 
AcceptFastInfoset ); 

Parameters 
The following arguments are valid for this function: 

Argument Data 
type 

Required Description 

URL String Yes This argument specifies the URL to which the script should 
send an HTTP request. If the HTTP request requires SSL then 
the URL must start with https. 

SOAPAction String Yes This argument specifies the SOAPAction value. 

XML String Yes This argument contains the XML for an entire SOAP request 
including the SOAP envelope. Refer to the Web Service's WSDL 
to determine the proper format of the SOAP request. 

SOAP user ID String No This argument contains the user ID to be used for the Basic 
Authorization HTTP header.   

SOAP password String No This argument contains the password value to be used for the 
Basic Authorization HTTP header. 

Attachment 
object 

Array No This argument contains a JavaScript array of Service Manager-
defined Attachment objects or an empty array. See the 
Attachment object for more information. 

AcceptFastInfoset Number No To set the SOAP Message flag "acceptfastinfoset". The default 
value is 1. To turn "acceptfastinfoset" off, set the value to 0. 

Return values 
A string containing a SOAP response or an error message. 

Description 
This method sends a SOAP request to a remote server and returns the SOAP response. 

Examples 
Example 1 does the following: 
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• Sends a SOAP request to a delayed stock quote Web service and indicates Service Manager accepts the 
"fastinfoset" formatted SOAP message. 

• Prints the SOAP response to the screen 

This example requires the following sample data: 

• The URL to a delayed stock quote Web service 

• Stock symbol for the company 

var url = "http://ws.cdyne.com/delayedstockquote/delayedstockquote.asmx"; 

var action = "http://ws.cdyne.com/GetQuote"; 

var xml = "<soap:Envelope xmlns:soap=\"http://schemas.xmlsoap.org/soap/envelope/\" 
xmlns:xsi=\"http://www.w3.org/2001/XMLSchema-instance\" 
xmlns:xsd=\"http://www.w3.org/2001/XMLSchema\" 
xmlns:s0=\"http://ws.cdyne.com/\"><soap:Body><GetQuote xmlns=\"http://ws.cdyne.com/\"><StockSymbol 
xsi:type=\"s:string\">GOOG</StockSymbol><LicenseKey 
xsi:type=\"s:string\">0</LicenseKey></GetQuote></soap:Body></soap:Envelope>"; 

var uid = null; 

var pass = null; 

var attachments = new Array(); 

var quote = doSOAPRequest( url, action, xml, uid, pass, 60, 60, null, attachments ); 

print( "The return value is: " + quote ); 

Example 2 does the following: 

• Sends a SOAP request to a delayed stock quote Web service and indicates SM does not accept the 
"fastinfoset" formatted SOAP message. 

• Prints the SOAP response to the screen 

This example requires the following sample data: 

• The URL to a delayed stock quote Web service 

• Stock symbol for company 

var url = "http://ws.cdyne.com/delayedstockquote/delayedstockquote.asmx"; 

var action = "http://ws.cdyne.com/GetQuote"; 

var xml = "<soap:Envelope xmlns:soap=\"http://schemas.xmlsoap.org/soap/envelope/\" 
xmlns:xsi=\"http://www.w3.org/2001/XMLSchema-instance\" 
xmlns:xsd=\"http://www.w3.org/2001/XMLSchema\" 
xmlns:s0=\"http://ws.cdyne.com/\"><soap:Body><GetQuote xmlns=\"http://ws.cdyne.com/\"><StockSymbol 
xsi:type=\"s:string\">GOOG</StockSymbol><LicenseKey 
xsi:type=\"s:string\">0</LicenseKey></GetQuote></soap:Body></soap:Envelope>"; 

var uid = null; 

var pass = null; 

var attachments = new Array(); 

var quote = doSOAPRequest( url, action, xml, uid, pass, 60, 60, null, attachments, 0 ); 

print( "The return value is: " + quote ); 
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Verified Environments 

The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software products, 
and other compatibility and support information.  

To access the Compatibility Matrix:  

1 Use a browser to navigate to the Software Support Online (SSO) web page:  
http://support.openview.hp.com/sc/support_matrices.jsp 

2 Log on with your Customer ID and password or your HP Passport sign-in.  

3 Navigate to the applicable information.  

Local Language Support 

UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 
language. Service Manager 9.21 supports UTF-8 as an encoding method for new or existing data. It can 
support multiple languages that adhere to the Unicode standard on the same server. 

Support 

You can visit the HP Software support web site at: 
www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 
http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 
http://h20229.www2.hp.com/passport-registration.html 

http://support.openview.hp.com/sc/support_matrices.jsp�
http://h20230.www2.hp.com/new_access_levels.jsp�
http://h20229.www2.hp.com/passport-registration.html�
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Legal Notices 

© Copyright 1994-2011 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product 
includes software written by Tim Hudson (tjh@cryptsoft.com). Smack software copyright © Jive Software, 
1998-2004. SVG Viewer, Mozilla JavaScript-C (SpiderMonkey), and Rhino software Copyright © 1998-2004 
The Mozilla Organization. This product includes software developed by the OpenSSL Project for use in the 
OpenSSL toolkit. (http:// www.openssl.org). OpenSSL software copyright 1998-2005 The OpenSSL Project. 
All rights reserved. This project includes software developed by the MX4J project 
(http://mx4j.sourceforge.net). MX4J software copyright © 2001-2004 MX4J Team. All rights reserved. 
JFreeChart software © 2000-2004, Object Refinery Limited. All rights reserved. JDOM software copyright © 
2000 Brett McLaughlin, Jason Hunter. All rights reserved. LDAP, OpenLDAP, and the Netscape Directory 
SDK Copyright © 1995-2004 Sun Microsystems, Inc. Japanese Morphological Analyzer © 2004 Basis 
Technology Corp. The Sentry Spelling-Checker Engine Copyright © 2000 Wintertree Software Inc. Spell 
Checker copyright © 1995-2004 Wintertree Software Inc. CoolMenu software copyright © 2001 Thomas 
Brattli. All rights reserved. Coroutine Software for Java owned by Neva Object Technology, Inc. and is 
protected by US and international copyright law. Crystal Reports Pro and Crystal RTE software © 2001 
Crystal Decisions, Inc., All rights reserved. Eclipse software © Copyright 2000, 2004 IBM Corporation and 
others. All rights reserved. Copyright 2001-2004 Kiran Kaja and Robert A. van Engelen, Genivia Inc. All 
rights reserved. Xtree copyright 2004 Emil A. Eklund. This product includes software developed by the 
Indiana University Extreme! Lab (<http:// www.extreme.indiana.edu/>). Portions copyright © Daniel G. 
Hyans, 1998. cbg.editor Eclipse plugin copyright © 2002, Chris Grindstaff. Part of the software embedded in 
this product is gSOAP software. Portions created by gSOAP are copyright © 2001-2004 Robert A. van 
Engelen, Genivia Inc. All Rights Reserved. Copyright © 1991-2005 Unicode, Inc. All rights reserved. 
Distributed under the Terms of Use in http:// www.unicode.org/ copyright.html.  

For information about third-party license agreements, see the licenses directory on the product installation 
DVD (\redistributables\licenses).  

Java™ and all Java based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries.  

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.  

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.  

UNIX® is a registered trademark of The Open Group. 
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